The User Manual of

Artifex 2

Desktop 3D Printer

http://3dmakerworld.com

Document date: July 12, 2017
(Check website for latest update)
## Contents

1. **Introduction**  
   1.1 Key Features and Sample Prints ........................................ 5  
   1.2 Specifications ......................................................... 7  
   1.3 Safety ................................................................. 9  
   1.4 Acknowledgements .................................................... 9  
   1.5 Overview of chapters ............................................... 10  

2. **Getting Started** ...................................................... 11  
   2.1 Setting up software environment .................................... 11  
      2.1.1 Installing electronics driver .................................. 11  
      2.1.2 Uploading firmware .............................................. 16  
      2.1.3 Installing and configuring printing software ............... 24  
   2.2 Setting up printer hardware ........................................ 31  
      2.2.1 Checking mechanical motion (kit package only) ........... 33  
      2.2.2 Leveling HBP .................................................... 35  
      2.2.3 Loading filaments .............................................. 39  
   2.3 Printing out your first 3D model .................................. 42  

3. **Slicing 3D Models** ................................................... 46  
   3.1 Getting 3D models ..................................................... 46  
      3.1.1 Creating your own 3D models ................................ 46  
      3.1.2 Downloading 3D models from online repositories ........ 46  
   3.2 Generating G-code from 3D models ................................ 47  
      3.2.1 Loading 3D models .............................................. 47  
      3.2.2 Slicing 3D models using Slic3r ............................... 48  
      3.2.3 Slicing 3D models using CuraEngine ......................... 53  

4. **Printing with ABS Filaments** ....................................... 58  
   4.1 Configuring printing settings ...................................... 58  
      4.1.1 The printer settings .......................................... 58  
      4.1.2 The slicing settings .......................................... 59  
   4.2 Preparing print surface ............................................. 59  

5. **Printing with Flexible Filaments** ................................ 61  
   5.1 Printing NinjaFlex with Slic3r .................................... 61  
   5.2 Printing NinjaFlex with CuraEngine ............................... 63  

6. **Printing with Dual Extruders** ..................................... 65  
   6.1 Printer Settings in Repetier-Host ................................ 65  
   6.2 Calibrating dual extruders ......................................... 69  
      6.2.1 Leveling two nozzles (Not required for assembled package) 69  

http://3dmakerworld.com
<table>
<thead>
<tr>
<th>6.2.2</th>
<th>Defining nozzle offsets</th>
<th>71</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.3</td>
<td>Printing with two colors</td>
<td>74</td>
</tr>
<tr>
<td>6.4</td>
<td>Printing with dissolvable support materials</td>
<td>78</td>
</tr>
<tr>
<td>6.5</td>
<td>Using one extruder</td>
<td>80</td>
</tr>
</tbody>
</table>

7 Printing with LCD Controller | 82 |

8 Support | 85 |
1 Introduction

The 3DMakerWorld Artifex 2 is an open source desktop 3D printer. It makes three-dimensional objects out of plastic filaments (PLA, ABS, PVA, HIPS, and NinjaFlex) layer by layer. Based on the design of Artifex 3D printer, the Artifex 2 adds the flexible filament extrusion and dual-head extrusion capabilities, LCD controller with SD card read, and other fine improvements. The Artifex 2 offers both single and dual extruder models (Figure 1.1). The design of Artifex 2 3D Printer is open to the public under the Creative Commons Attribution-ShareAlike 3.0 Unported license (CC BY-SA 3.0).

Artifex 2 All Metal (Figure 1.2) is an all metal hotend version of Artifex 2. It is equipped with E3D V6 all metal hotend to extrude up to 300C for expanded material capacity, including Nylon and Polycarbonate. Except for the hotend set-up, Artifex 2 All Metal shares the same structure as Artifex 2. Unless explicitly noted, information provided in this document for Artifex 2 applies to Artifex 2 All Metal as well.
1 INTRODUCTION

1.1 Key Features and Sample Prints

The key features of Artifex 2 3D printer include:

- Flexible Material Extrusion
- Single- & Dual-Head Extrusion
- LCD Controller & SD Card Reader
- Large Build Volume: 952 (Single) / 640 (Dual) cubic inch
- High Layer Resolution: 50 micron
- Fast Print Speed: 150 mm/sec

Below are some sample prints made with the Artifex 2 3D printers. Please check more sample prints and printing videos at our website.

http://3dmakerworld.com
1 INTRODUCTION

Figure 1.3: Recreus sandals (thing:404014) printed by Artifex 2

Figure 1.4: Giant hollow two color world (thing:15658) printed by Artifex 2 Duo

http://3dmakerworld.com
1 INTRODUCTION

Figure 1.5: Yoda bust (thing:14104) printed by Artifex 2

Figure 1.6: The T-Rex skull (thing:308335) printed by Artifex 2

1.2 Specifications

The technical specifications of Artifex 2 3D printers are listed in Figure 1.7.

http://3dmakerworld.com
<table>
<thead>
<tr>
<th>PRINTING</th>
<th>Artifex 2 (Single Extruder)</th>
<th>Artifex 2-Duo (Dual Extruder)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRINT TECHNOLOGY</td>
<td>Fused Filament Fabrication</td>
<td></td>
</tr>
<tr>
<td>PRINT DIMENSION</td>
<td>230W x 310D x 223H mm ( (9 \times 12.2 \times 8.8 \text{ in}) ) ( \text{All Metal: } 9 \times 12.2 \times 8.3 \text{ in} ) ( \text{Span 198mm along X-axis on top 30mm} )</td>
<td>156W x 310D x 223H mm ( (6.1 \times 12.2 \times 8.8 \text{ in}) ) ( \text{All Metal: } 6.1 \times 12.2 \times 8.3 \text{ in} ) ( \text{Span 124mm along X-axis on top 30mm} )</td>
</tr>
<tr>
<td>BUILD VOLUME</td>
<td>15,602 cm³ ( (952 \text{ in}³) ) ( \text{All Metal: } 14,747 \text{ cm}³ ( (900 \text{ in}³) )</td>
<td>10,486 cm³ ( (640 \text{ in}³) ) ( \text{All Metal: } 9,906 \text{ cm}³ ( (605 \text{ in}³) )</td>
</tr>
<tr>
<td>LAYER RESOLUTION</td>
<td>50 micron</td>
<td></td>
</tr>
<tr>
<td>POSITIONING PRECISION</td>
<td>X/Y: 12.5 micron ( (0.0005 \text{ in}) ) ( \text{Z: } 0.66 \text{ micron } (0.000026 \text{ in}) )</td>
<td></td>
</tr>
<tr>
<td>NOZZLE DIAMETER</td>
<td>0.35 mm ( (0.014 \text{ in}) )</td>
<td></td>
</tr>
<tr>
<td>FILAMENT DIAMETER</td>
<td>1.75 mm ( (0.069 \text{ in}) )</td>
<td></td>
</tr>
<tr>
<td>PRINT MATERIAL</td>
<td>PLA, ABS, NinjaFlex, HIPS, PVA, Nylon ( \text{All Metal} ), Polycarbonate ( \text{All Metal} )</td>
<td></td>
</tr>
<tr>
<td>TOP PRINT SPEED</td>
<td>150 mm/sec</td>
<td></td>
</tr>
</tbody>
</table>

**ELECTRICAL**

| POWER REQUIREMENTS | 110/220 VAC |
| ELECTRONICS        | RAMBo        |
| HOT-END             | J-Head Mk V-BV up to 240°C \( \text{All Metal: } E3D V6 \) up to 300°C |
| HEATED BED          | 24V 200W heated bed up to 120°C |
| MOTOR TORQUE        | XYZ: 5.5 kg-cm \( (75.4 \text{ oz-in}) \) \( \text{Extruder: } 9 \text{ kg-cm } (125 \text{ oz-in}) \) |
| COOLING FAN         | 24V Ball Bearing |

**SOFTWARE**

| PRINT SOFTWARE | Host: Repetier-Host; Slicing: Cura Engine, Slic3r |
| FILE TYPES      | STL, G-Code |
| CONNECTIVITY    | USB, LCD (SD Card) |
| OPERATING SYSTEMS | Windows XP/Vista/7/8, Linux, Mac OS X |

**DIMENSION & WEIGHT**

| PRODUCT DIMENSION (WITH 8” SPOOL) | 520W x 530D x 480H (mm) \( 20.5 \times 20.9 \times 18.9 \text{ (in)} \) |
| PRODUCT WEIGHT (WITHOUT SPOOL)    | 11.5 Kg \( (25.3 \text{ lbs}) \) | 12.4 Kg \( (27.3 \text{ lbs}) \) |

---

Figure 1.7: The technical specifications of Artifex 2

http://3dmakerworld.com
1.3 Safety

WARNING: The 3DMakerWorld Artifex 2 3D Printer generates high temperature and contains fast moving mechanical parts which may cause injury or damage. Please follow the guidelines carefully to operate the printer safely. 3D Maker World assumes no liability for any loss or injury caused by operating the Artifex 2 3D Printer.

- Never leave your 3D printer unattended during printing or with power on.
- Provide sufficient clear space around the printer to permit free motion of moving parts, including the front-back movement of build platform, the up-down movement of X-axis assembly, and the rotation of filament spool.
- When the printer is in operation, never touch moving parts, including belts, pulleys, motor shafts, rail carriages, and lead screws.
- Never touch the extruder nozzle and heated bed without turning off the power and allowing them to completely cool down.
- Always power off the printer and disconnect USB cable before any service or troubleshooting operation.
- Always discharge yourself by touching a grounded source before touching the electronics.
- Never leave flammable materials near printer.
- Place the printer in a well-ventilated area for printing with ABS filaments.

1.4 Acknowledgements

First, we would like to thank Maxbot for his design of MendelMax 2, which is arguably one of the most compact desktop 3D printer designs considering the build volume and footprint. The overall structure is what the Artifex and Artifex 2 3D printers were built upon. Through improved product features and expanded functionalities, we believe Artifex 2 can offer the next level of excellence to enable your 3D printing capability.

Secondly, we would like to thank the developers of open source programs used in the Artifex 2 software toolchain, including:

- Repetier-Host: the 3D printing user interface
- CuraEngine, Slic3r: G-code generators, included in the Repetier-Host
- Marlin: the firmware of 3D printer
- Arduino: used to upload and edit the firmware of Artifex 3D Printer

http://3dmakerworld.com
We would also like to address our sincere thanks to our customers of the first generation of Artifex 3D printers. All of your feedback and suggestions have made our products even better and more capable.

Last, but certainly not the least, our gratitude to all the pioneers, makers and active players in the reprap and other 3D printing communities for all the inspiration and support.

1.5 Overview of chapters

Chapter 2 will be focused on how to set up the software environment and the printer hardware for printing using PLA filaments. By the end of Chapter 2, you will be able to print out your first 3D model using a pre-generated g-code for the Artifex 2 3D printer.

Chapter 3 will discuss how to generate g-code from a 3D model of your choice, either from your own creation or from an online 3D model repository. A few 3D modeling tools and online 3D model repositories will be introduced. And the main content of Chapter 3 will be focused on the set-up of slicing parameters.

Chapter 4, and 5 will cover the configuration of printing parameters and printer set-up for printing with ABS and flexible filaments, respectively. Chapter 6 will discuss how to use your Artifex 2 Duo 3D Printer. Chapter 6 will list our support information for future assistance.
2 Getting Started

2.1 Setting up software environment

The software set-up in this section is based on a Windows operating system. The similar steps applies to set-ups for Mac or Linux based computers. All the software can be downloaded on our website.

2.1.1 Installing electronics driver

Like other device drivers, the electronics driver of your 3D printer allows your computer to recognize the printer when you connect it to the computer. The Artifex 2 3D Printer uses the RAMBo electronics from Ultimachine. No installation is required for Mac and Linux systems. The driver file for Windows, RAMBo_USBdriver.zip, can be downloaded on our website. Follow steps below to install the driver for Windows:

1. Download the driver and save it in a folder of your choice. In our case, we saved the file on the desktop.

2. Unzip the compressed file using 7-Zip or other archive programs. (Figure 2.1)

![Figure 2.1: Unzip the driver file using 7-Zip](http://3dmakerworld.com)

3. Connect the printer to your computer via the provided USB cable. At the first time of connecting Artifex 2 to your computer, your computer will likely fail to allocate a driver for the hardware to work correctly. We will manually update the device driver.

http://3dmakerworld.com
4. Open the Device Manager under "Control Panel → System and Security → System". Under "Other devices", you will find the RAMBo device, right click and select "Update Driver Software...". (Figure 2.2)

![Device Manager](image)

Figure 2.2: Update driver software

5. A window will pop up, asking whether to "Search automatically..." or "Browse my computer...". Select "Browse my computer...". (Figure 2.3)
6. In the popped up window, select the folder where you unzipped the archive file. In our case, the location is "C:\Desktop\RAMBo_USBdriver". Then, click "Next". (Figure 2.4)
7. A security window may pop up (Figure 2.5). If so, click "Install".

8. After the installation, you will be noticed that "Windows has successfully updated your driver software". Click "Close". (Figure 2.6)
9. Now, the RAMBo electronics will appear under the "Ports (COM & LPT)". Write down the COM port which the electronics uses. We will need this information later when setting up the printing software. In our case, it is COM3. (Figure 2.7)
2.1.2 Uploading firmware

(\textit{Note: All Artifex 2 packages, including both fully assembled and kit packages, are now shipped with firmware pre-loaded. The instructions below are provided for users who want to modify and update the firmware for advanced usage.})

The firmware of your 3D printer is like the operating system of your computer. The Artifex 2 3D Printer uses a customized Marlin-based firmware.

- For a fully assembled Artifex 2 3D Printer, its firmware is already loaded before the shipment. You can skip this section. In the future, if you need to update the firmware for your Artifex 2 3D Printer, please follow steps listed in this section.

- For a kit package of Artifex 2 3D Printer, after you install the electronics, you need to upload its firmware.

1. Download the Arduino software

\url{http://3dmakerworld.com}
The RAMBo electronics used in your Artifex 2 3D Printer is an Arduino-compatible control board. The Arduino integrated development environment (IDE) software will be installed on your computer to communicate with the printer electronics. The Arduino IDE software runs on Windows, Mac OS X, and Linux, and can be downloaded from [http://arduino.cc/en/Main/Software](http://arduino.cc/en/Main/Software). The following steps are based on the Arduino 1.0.5 released version for Windows.

- Download the Zip file of Arduino software (**arduino-1.0.5-windows.zip**), and save it to your computer’s Desktop or a location of your choice.
- Unzip the file using 7-Zip or other archive software (Figure 2.8). The unzipped files will appear in a folder named “**arduino-1.0.5**”.

![Figure 2.8: Unzip the Arduino zip file using 7-Zip](image)

- Open the folder and there is a file named “**arduino.exe**” (Figure 2.9). It is the executable program of the Arduino IDE software. No further installation is needed.
2. Add library files for LCD controller

A library is required to use the LCD controller on Artifex 2. The library can be downloaded at: https://bintray.com/olikraus/u8glib/Arduino. After unzipped, the library can be imported in Arduino IDE by selecting the menu "Sketch→Import Library...→Add Library..." and then pointing to the folder of unzipped library files.

3. Upload the firmware of Artifex 2 3D Printer

The Artifex 2 3D Printer is shipped with a customized Marlin-based firmware.

- Download the Artifex 2 firmware from http://3dmakerworld.com/support/downloads, save it to your computer’s Desktop or a location of your choice. (Note: For Artifex 2 All Metal, select the All Metal version of firmware.)
- Unzip the file using 7-Zip or other archive software. (Figure 2.10)
• Open the Arduino IDE software, arduino.exe. The software interface is shown in Figure 2.11.
• Click “File → Open...” (Figure 2.12).

![Figure 2.12: Open files in the Arduino IDE software](image)

- Select the file “Marlin.ino” in the unzipped Artifex 2 firmware file folder “C:\Desktop\Artifex2Firmware1.0\Marlin” (Figure 2.13), and click “Open”. Figure 2.14 shows the Arduino IDE with opened Artifex 2 firmware files.

![Figure 2.13: The main file of Artifex 2 firmware “Marlin.ino”](image)
• Select “Tools → Board → Arduino Mega 2560 or Mega ADK”. (Figure 2.15)

• Select “Tools → Serial Port → COM3”. (Figure 2.16)
• Select “File → Upload” to upload the Artifex 2 firmware to its electronics (Figure 2.17). Before uploading, the Arduino IDE will first compile the firmware files. The progress of compiling and uploading is shown in the bottom status window.
If the uploading is successful, you will see the message of “Done uploading” in the bottom status window (Figure 2.18). If the compiling or uploading is not successful, the error message will be shown in the status window as well. Common causes of uploading failure include: wrong Arduino board type, wrong serial port, or serial port conflict (e.g., the same serial port is used by your printing software, which will be covered later in this section). For other error message, please refer to the Arduino manual or contact our technical support.
2.3 Installing and configuring printing software

A printing software provides the user interface to operate your 3D printer. We recommend the Repetier-Host printing software due to its user-friendly interface and all-in-one features. Repetier-Host can work on Windows, Mac, and Linux systems. The following steps are based on the Windows version 1.0.6.


2. Run the set-up file to install the Repetier-Host software. After the installation, open the Repetier-Host. (Figure 2.19)
3. Configure the Repetier-Host for your Artifex 3D Printer.

- Open the **Printer Settings** from “Config → Printer Settings” (Figure 2.20).

- In the window of Printer Settings (Figure 2.21), enter the printer name “Artifex 2” on the top, and configure settings on the “Connection” page as shown in the figure. Make sure the port number matches the serial number used by your Artifex 2 3D Printer.
Configure the settings on the “Printers” page (Figure 2.22). Depending on your printing materials, the default temperature of extruder and heated bed can be set to either 185C/70C (PLA), or 230C/95C (ABS).
• Configure the settings on the “Extruder” page. (Figure 2.23) (Note: For Artifex 2 All Metal, change the extruder diameter to 0.4mm.)
• Configure the settings on the “Printer Shape” page. (Figure 2.24)
Configure the settings on the “Advanced” page. Nothing to change on the page. Just click “OK” and the Repetier-Host is ready to use with your Artifex 3D Printer. (Figure 2.25)
• Click the drop-down arrow next to the “Connect” button, and select “Artifex 2” (Figure 2.26). The Repetier-Host is now connected with your Artifex 3D Printer, as confirmed by the message shown on the bottom status bar (Figure 2.27).

Figure 2.25: Printer Settings: Advanced

Figure 2.26: Connecting with Artifex 2 3D Printer
2.2 Setting up printer hardware

Caution: Before powering up your Artifex 2 3D Printer, check the voltage selection of the Power Supply Unit (PSU) on the bottom left of your Artifex 2 3D Printer, and make sure it matches the voltage supply in your area. (Figure 2.28)
Insert the power cord into the AC input receptacle on the back of your Artifex 2 3D Printer. Plug the power cord into an electrical outlet, and turn on the power switch next to the AC input receptacle. (Figure 2.29)
2.2.1 Checking mechanical motion (kit package only)

The mechanical movement has been checked in a fully assembled Artifex 2 3D printer. The process listed in this section is only needed if you are assembling your own Artifex 2 3D printer from a kit package, although information provided here can help you gain better understanding of your Artifex 2 3D printer even you start with a fully assembled Artifex.

Figure 2.30 shows the X/Y/Z-axis definition of your Artifex 2 3D Printer. The extruder moves along the X- and Z-axis, and the heated build platform (HBP) moves along the Y-axis. The extruder’s X/Y/Z position is defined relative to the HBP.

Figure 2.31 shows commands in the Manual Control page of Repetier-Host for mechanical movement.
Step 1 Checking moving directions

Use the X/Y/Z arrow commands to test the moving direction of extruder and HBP. If either one moves in a wrong direction along X/Y/Z-axis, open the electronics case by taking off its top cover to check the connection of motor cables on the electronics board. The red wire of motor cable should face towards the front of printer (Figure 2.32).

Caution:

1. Make sure there is enough distance for the extruder/HBP to move freely without bumping onto the frame/HBP before sending out a control command.
2. Power off the printer and unplug the USB cable before you open the electronics case or flip the connector of any motor cable.
3. When opening the electronics case, be careful not to break the cable of electronics fan, which is mounted on the top cover of electronics case.
Step 2 Checking homing functions

The X/Y/Z mechanical endstops are installed at the $x = 0$, $y = 0$, and $z = 0$ position, respectively. During homing, whenever the X/Y/Z endstop is triggered, the motor(s) in that axis will be stopped and the position of extruder’s nozzle tip will be registered as the origin of that axis.

- Click the “Home X” icon. The extruder will move to the left until it triggers the X-axis endstop.
- Click the “Home Y” icon. The HBP will move backwards until it triggers the Y-axis endstop.
- Z-axis homing will be tested in the next section when leveling HBP.

2.2.2 Leveling HBP

A 3D object is formed layer by layer by extruding the melt filament onto the last layer of object. The first layer of object is directly printed onto the printing surface. In order to
achieve successful and high-quality printing, it is very important to set a proper distance between the nozzle tip and the HBP across the entire printing surface at the start of printing.

- If the nozzle tip is too far from the HBP, the print will not stick well to the printing surface.
- If the nozzle tip is too close to the HBP, the extrusion flow may be blocked during printing, and the nozzle tip may scratch the HBP or previous layers of print.

At the $z = 0$ position, a recommended distance between the nozzle tip and the HBP for most printing tasks is 0.1mm, which is about the thickness of a piece of thin paper.

**Step 1 Preparation**

- Click the “Turn Motor Off” button on the Manual Control page of Repetier-Host interface (Figure 2.31) to turn off power of all motors so you can perform manual operation in the following steps.
- Check if X-axis is level with the frame. Measure the distance between the X-axis rail and the top motor mount on both left and right sides (Figure 2.33). If these two measurements are different, manually turn either left or right motor shaft coupler to raise/lower the X-axis on one side to match with the height of another side.

![Figure 2.33: Checking the levelness of X-axis](http://3dmakerworld.com)

- Adjust the 3-point bed leveling thumb screws to let the bottom of hex screw be flush with the bottom of thumb screw (Figure 2.34). This operation is to ensure
that the 3-point leveling thumb screws will have enough up/down adjusting room for HBP leveling.

Figure 2.34: The bottom of thumb screw being flush with the bottom of hex screw

Step 2 Zeroing Z-axis

- Manually move the extruder to the middle of X-axis and the HBP to the middle of Y-axis so the extruder’s nozzle tip points towards the center of HBP.
- Use the "Z" arrow commands to carefully lower the extruder to get it close to the HBP.
- Adjust the Z-axis endstop trigger screw in the back of right X-end (Figure 2.35) so the extruder’s nozzle tip almost touches the HBP when the Z-axis endstop is triggered. You may need to raise and home the Z-axis several times to finish this step.
Step 3 Leveling HBP

- Manually move the extruder to the middle of HBP left edge.
- Slide the 0.1mm feeler gauge provided in your Artifex 2 package between the nozzle tip and the HBP.
- Adjust the left leveling thumb screw until the feeler gauge can just slide between the nozzle and the HBP with some resistance.
- Manually move the extruder to the right-front corner of HBP. Adjust the right-front leveling thumb screw until the feeler gauge, or the paper, can just slide between the nozzle and the HBP with some resistance.
- Manually move the extruder to the right-rear corner of HBP. Adjust the right-rear leveling thumb screw until the feeler gauge, or the paper, can just slide between the nozzle and the HBP with some resistance.
- Repeat the above steps for 2-3 times to ensure the HBP is level. After the HBP leveling, the distance between nozzle tip and the HBP is about 0.1mm across the print surface. (Figure 2.36)
Note:

1. Do not be confused with the 3-point thumb screws in the middle of Y-axis mount plate and the bed tightening screws in the four corners of HBP. (Figure 2.37)

2. When adjusting the 3-point thumb screws, you may feel it is very tight to turn the screws. This is normal. The Artifex 3D Printer uses quite strong wave springs for bed leveling to prevent the screw to get loose during printing.

2.2.3 Loading filaments

Step 1 Feeding filament through the filament guide tube

Free the end of filament from the filament spool, and cut off the bent section used to secure the filament to the spool. Feed the filament into the rear end of filament guide

http://3dmakerworld.com
tube (Figure 2.38), and push it through the tube until it reaches the filament drive in the front end of filament guide tube.

Figure 2.38: Feeding filament through the filament guide tube

**Step 2 Heating up extruder**

On the “Manual Control” page of Repetier-Host, there is an “Extruder” section (Figure 2.39). After the Repetier-Host is connected with your Artifex 2 3D printer, the extruder target temperature shows 185°C as we set in Chapter 2, and the extruder is turned off. Click the Extruder icon to heat up the extruder to the target temperature.

Figure 2.39: Extruder control commands on Repetier-Host interface

The Repetier-Host provides a nice temperature monitoring interface. You can configure the parameters and preference on the “Temperature Curve” page. (Figure 2.40)
Step 3 Extruding filament through the extruder

- Once the extruder temperature reaches a steady state at the target of 185°C, pop up the filament guide tube from the filament drive, and gently push the filament into the filament drive. (Figure 2.41)

- Click the down buttons on the Repetier-Host interface (Figure 2.31) to extrude 50mm of filament through the filament drive at the speed of 100mm/min.
- Continue gently pushing the filament downwards until you feel the pulling from the extruder motor.
- If needed, click the DOWN buttons again to extrude out more filament until you see a steady stream of melt filament extruded out of the extruder nozzle. (Figure 2.42)
2.3 Printing out your first 3D model

In this section, you will print out a 3D model from a pre-generated G-code file. The G-code file contains a list of instructions to control your Artifex 2 3D printer to make a 3D model layer by layer. Chapter 4 will discuss how to generate the g-code from a 3D model file to print out any 3D model of your choice.

1. Before your printing, clean the print surface using 91% rubbing alcohol (Figure 2.43) with a piece of paper towel. The 91% rubbing alcohol is available in most local grocery stores.
2. Download a G-code file, for example “CuteOcto_PLA.gcode”, from our website and save it to your computer’s Desktop or a location of your choice.

3. On the Repetier-Host interface, click the “Load” button on the top menu bar (Figure 2.44). Locate the downloaded file “CuteOcto_PLA.gcode” and open it.

4. The Repetier-Host interface with the loaded file is shown in Figure 2.45.
5. Click the “Start Print” button on the top menu bar (Figure 2.46). The printer will follow the instructions in the G-code to initialize its position and heat up the extruder and HBP. Once both the extruder and HBP reach their target temperature, the printer will start the print job.

6. After the print job is done, you will get your first 3D model printed out from your Artifex 2 3D model (Figure 2.47). Wait until both the extruder and HBP completely cool down before you take off the print off the HBP.
Figure 2.47: Printed cute octopus 3D model
3 Slicing 3D Models

In this chapter, we will discuss how to generate the G-code for your Artifex 2 3D Printer from a 3D model of your choice, either downloaded from an online 3D model repository or created by your own. Discussion in this chapter is based on printing with PLA filaments. Printing with ABS filaments will be covered in the next Chapter.

3.1 Getting 3D models

3.1.1 Creating your own 3D models

A 3D model can be created by various 3D modeling software. Some examples include:

**Free 3D modeling software:**
- OpenSCAD: [http://www.openscad.org](http://www.openscad.org)
- Blender: [http://www.blender.org](http://www.blender.org)
- SketchUp: [http://www.sketchup.com](http://www.sketchup.com)
- FreeCAD: [http://www.freecadweb.org](http://www.freecadweb.org)
- Tinkercad: [http://www.tinkercad.com](http://www.tinkercad.com)

**Commercial 3D modeling software:**
- SolidWorks: [http://www.solidworks.com](http://www.solidworks.com)
- AutoCAD: [http://www.autodesk.com](http://www.autodesk.com)

3.1.2 Downloading 3D models from online repositories

You can also download 3D models from online repositories, for example,

- Thingiverse: [http://www.thingiverse.com](http://www.thingiverse.com)
- GrabCAD: [http://www.grabcad.com](http://www.grabcad.com)

A 3D model can be saved in different file formats. The STereoLithography (STL) format is a format widely used for 3D printing. In the following discussion, it is assumed that the 3D model you created or downloaded is already saved in a STL file format.
3.2 Generating G-code from 3D models

After you get a 3D model, you need to slice it into horizontal layers for your Artifex 2 3D Printer to print it out layer by layer. The instructions which command your Artifex 2 3D Printer to do the layer-by-layer printing are saved in a G-code file. The translation from a digital 3D model into a G-code file is processed by a slicing program called slicer. In this chapter, we introduce two slicers, CuraEngine and Slic3r, which have been integrated in the Repetier-Host printing software. CuraEngine is easier to start with due to its arguably more intuitive parameter settings, while Slic3r offers more control options for you to fine tune the printing process once you get familiar with the settings.

3.2.1 Loading 3D models

1. Download the STL file (CuteOcto.stl) for the cute octopus model from our website, and save it to your computer’s Desktop or a location of your choice.

2. On the Repetier-Host interface, click the “Load” button on the top menu bar. Locate the downloaded file “CuteOcto.stl” and open it.

3. Once the loading is completed, the 3D model will be displayed on the left “3D View” window, where you can rotate, zoom, move the model to view the 3D model. The “Object Placement” page on the right side listed the file name of loaded 3D model, available placement operations, and some model information. (Figure 3.1)
3.2.2 Slicing 3D models using Slic3r

- Click the “Slicer” page next to the “Object Placement” page on the right side of Repetier-Host interface. Select “Slic3r” in the Slicer option (Figure 3.2).
Click the “Configuration” button, and a separate window will pop up showing the Slic3r program (Figure 3.3).
Slicing settings in Slic3r are organized into three sections: Print Settings, Filament Settings, and Printer Settings. The detailed explanation of all parameters in these sections is available from the Slic3r Manual (http://manual.slic3r.org/). Some configuration examples are provided on our website for you to start with your Artifex 2 3D Printer. The process below shows how to import such configuration files into Slic3r to slice your 3D models. Once you get more familiar with the Slic3r program and the printing process, you can tweak slicing parameters to meet your specific needs for different models.

- Download a slicing configuration file, for example Artifex2_PLA.ini, from our website, and save it to your computer’s Desktop or a location of your choice.

- In the Slic3r program window, click “File → Load Configure...” (Figure 3.4), and select the downloaded file Artifex2_PLA.ini.
On the “Print Settings” page, click the “Save” icon button next to the configuration file name “Artifex2_PLA.ini”. A window will pop up for you to enter the name of current Print Settings (Figure 3.5). Here, we just use the same name as the configuration file “Artifex2_PLA”. Then, click “OK”. Do the same to save filament settings and printer settings under the name “Artifex2_PLA”. Then, close the Slic3r program window.

On the Slicer page of Repetier-Host interface, select “Artifex2_PLA” for Print Settings, Printer Settings, and Filament Settings (Extruder 1) (Figure 3.2).

Click the “Slice with Slic3r” button. Once the slicing is completed, the Repetier-Host will look like what shown in Figure 3.6, which is the same as what you saw in the last chapter when you directly loaded a pre-generated G-code file.
Figure 3.6: Repetier-Host interface at the completion of model slicing

- The Repetier-Host program provides an excellent capability to visualize the generated G-code of your 3D models. Figure 3.7 shows the model from layer 1 to layer 92. When configuring your own slicing settings, this visualization feature will become very handy to check the slicing result before sending the job to your 3D printer.
3.2.3 Slicing 3D models using CuraEngine

- Click the “Slicer” page next to the “Object Placement” page on the right side of Repetier-Host interface. Select “CuraEngine” in the Slicer option (Figure 3.8).

Figure 3.7: Previewing the model based on the generated G-code

Figure 3.8: Slicer page on the Repetier-Host interface with CuraEngine
Click the “Configuration” button, and a separate page, named “Cura”, will be added to the left window next to the “Temperature Curve” page (Figure 3.9), including two configuration sub-pages: Print and Filament. The “Print” configuration files can be downloaded from our website, for example “Artifex2.rcp”, and imported by clicking the “Import” button.

Similarly, the “Filament” configuration files can also be downloaded from our website, for example “PLA.rcf”, and imported by clicking the “Import” button (Figure 3.10).
Then, select the print and filament settings on the right window (Figure 3.11). Additional options of Adhesion Type, Quality, Support Type, Speed, Infill Density, Enable Cooling can be specified for the CuraEngine slicer. In Figure 3.11, the default quality of 0.2mm, a medium speed and a 20% infill density were selected, and the cooling was enabled for PLA printing.
Figure 3.11: Specifying CuraEngine slicing parameters for printing with PLA

- After setting up the slicing parameters, click “Slice with CuraEngine” button, and after the slicing is completed, the G-code is previewed in Repetier-Host as shown in Figure 3.12.
Figure 3.12: Previewing G-code generated by CuraEngine
4 Printing with ABS Filaments

Printing with ABS filaments is very similar to printing with PLA filaments. The major differences for printing with ABS are:

- It requires higher temperature for both extruder and HBP, and
- The print surface needs to be covered by print tapes for the print to better stick to the HBP.

4.1 Configuring printing settings

Two configurations in Repetier-Host need to be changed to work with ABS filaments: the printer settings, and the slicing settings.

4.1.1 The printer settings

The printer settings for printing with PLA filaments are shown in Section 2.1.3. For printing with ABS filaments, the only difference will be the default extruder and heated bed temperatures. Change the Default Extruder Temperature to 230°C, and the Default Heated Bed Temperature to 95°C. (Figure 4.1)

Figure 4.1: Printer Settings in Repetier-Host for printing with ABS

http://3dmakerworld.com
4 PRINTING WITH ABS FILAMENTS

4.1.2 The slicing settings

For slicing with Slic3r, download the configuration file “Artifex2.ABS.ini” from our website. Then, follow the steps in Sections 3.2.2 to update slicing settings for printing with ABS filaments. The main difference from the settings for printing with PLA filaments are:

Filament settings Both extruder and bed are set at higher temperatures, and cooling is turned off for printing with ABS filaments.

Printer settings In the Custom G-code, higher extruder and bed temperature are set before the printing starts.

For slicing with CuraEngine, download the filament configuration file “ABS.rcf”, and import the file and slice the model following steps in Section 3.2.3.

4.2 Preparing print surface

1. Taking off glass plate

   (a) Loose thumb screws under the four HBP corners. (Figure 2.37)
   (b) Slide printed HBP corners outward away from the bed to release the glass top from the build platform. (Figure 4.2)
   (c) Carefully take off the glass top and place it on a flat table surface.

   Figure 4.2: Releasing glass plate from the HBP

2. Applying Kapton tape sheet onto glass plate
After extruded from the nozzle, ABS filaments can stick well to warm and clean print tapes. Both PET and Kapton tapes can be used for this purpose. Included in the Artifex 2 3D printer package are 10 pieces of die-cut Kapton tape sheets. These Kapton sheets have the same size as the glass top of 250x320mm, and are thick (0.08mm, or 3mil) and sturdy. For easy installation, these sheets come with easy-release liners.

(a) Place the glass plate on a flat table surface.
(b) Clean the glass surface with Windex or rubbing alcohol before applying the tape.
(c) Spray a thin layer of Windex onto the glass.
(d) Take one piece of Kapton tape sheet, and pear off the liner on the back.
(e) Place the Kapton sheet onto the glass top, and use the squeegee provided in the printer package to remove bubbles between the glass and the Kapton sheet.

3. Installing glass plate

(a) Carefully place the tape covered glass plate back to the build platform on the top of aluminum heat spreader.
(b) Slide printed HBP corners inward to secure the glass plate into the slots of HBP corners.
(c) Tight up the thumb screws under the four HBP corners to hold them in place.

4. Cleaning print surface A clean surface is very important for the print to stick well to the print tape. Clean the Kapton sheet using 91% rubbing alcohol (Figure 2.43) with a piece of paper towel.

Figure 4.3 shows the finished HBP with glass top covered by Kapton tape sheet.
5 Printing with Flexible Filaments

With a redesigned filament drive, the same extruder in Artifex 2 can extrude both flexible and rigid filaments. No tool change is needed when changing between rigid and flexible filaments. The NinjaFlex filaments are fully tested to work with Artifex 2. Artifex 2 Duo, which will be introduced in Chapter 6, uses the same extruder design as Artifex 2 and the settings for printing with NinjaFlex discussed in this chapter apply to Artifex 2 Duo as well.

5.1 Printing NinjaFlex with Slic3r

Download the slicing configuration file, Artifex2_NinjaFlex.ini, from our website. Then, follow the steps in Sections 3.2.2 to update slicing settings for printing with NinjaFlex filaments. The main difference from the settings for printing with ABS filaments are:

**Extrusion speed** Since flexible filaments are difficult to be pushed through extruder without bending, a lower printing speed is required when printing with flexible filaments. The recommended extrusion speed of NinjaFlex is 30mm/sec. We will set both perimeter and infill printing speed to 30mm/sec in the followings.

**Bed temperature** NinjaFlex filament can easily stick to the bed. The bed temperature will be set at 50°C to ensure a good adhesion of the first layer. The NinjaFlex can be printed on a bared or tape-covered glass top, although a bared glass will be easier to remove the model after printing.

Download the STL file (StackableCup.stl) for the demo model from our website and load the model into Repetier-Host. Then, download the Slic3r configuration file (Artifex2_NinjaFlex.ini), and load the file to Slic3r as explained in Section 3.2.2. Figure 5.1 shows the Repetier-Host interface with the demo model ready for slicing. Figure 5.2 shows the slicing result.
Figure 5.1: Demo model for printing with NinjaFlex

Figure 5.2: Slic3r slicing result for printing with NinjaFlex
5.2 Printing NinjaFlex with CuraEngine

Download the filament configuration file “NinjaFlex.rcf”, and import the file into Repetier-Host and slice the model following steps in Section 3.2.3. In Figure 5.3, the default quality of 0.2mm, a slow speed and a 25% infill density were selected, and the cooling was enabled for printing with NinjaFlex.

![CuraEngine Slicing Parameters](http://3dmakerworld.com)

Figure 5.3: Specifying CuraEngine slicing parameters for printing with NinjaFlex

After setting up the slicing parameters, click “Slice with CuraEngine” button, and after the slicing is completed, the G-code is previewed in Repetier-Host as shown in Figure 5.4.
Figure 5.4: CuraEngine slicing result for printing with NinjaFlex
6 Printing with Dual Extruders

6.1 Printer Settings in Repetier-Host

First, we need to create a printer profile in Repetier-Host for Artifex 2 Duo by following the configuration shown in Figure 6.1 to Figure 6.5. (Note: For Artifex 2 All Metal, change the extruder diameter to 0.4mm.)

![Printer Settings](http://3dmakerworld.com)

Figure 6.1: Artifex 2 Duo Printer Settings: Connection
Figure 6.2: Artifex 2 Duo Printer Settings: Printer
Figure 6.3: Artifex 2 Duo Printer Settings: Extruder
Figure 6.4: Artifex 2 Duo Printer Settings: Printer Shape
6.2 Calibrating dual extruders

6.2.1 Leveling two nozzles (Not required for assembled package)

If you built your Artifex 2 Duo from a kit package, you need to make sure the two nozzles are leveled before using them for printing. First, unplug the fan connectors, and unscrew the two M3×30 FHS screws on the fan assembly to take it off from the extruder (Figure 6.6).
With the fan assembly removed, perform the bed leveling process as explained in Section 2.2.2. If the two nozzles are not perfectly leveled, loose the M3×25 SHS screws to adjust the position of filament drives to level the two nozzles (Figure 6.7).
6.2.2 Defining nozzle offsets

On Artifex 2 Duo, the left extruder is defined as Extruder 1, and the right one Extruder 2. Ideally, the two extruders are perfectly aligned on the Y-axis direction, and positioned 42mm away from each other along the X-axis direction. However, the clearance allowance between mechanical components and other minor misalignments may change the offsets between these two nozzles. The default nozzle offsets are defined in the electronics firmware, where the offsets of Extruder 1 are always $X = 0$mm and $Y = 0$mm, and the offsets of Extruder 2 are $X = 42$mm and $Y = 0$mm.

- First, reset the nozzle offsets to the default values using the M218 command (Figure 6.8).

Figure 6.7: Leveling nozzles by adjusting position of filament drives

Figure 6.8: Initializing extruder offsets to the default values

http://3dmakerworld.com
• Download the Artifex 2 Duo Calibration G-code from our website, and load the code into Repetier-Host as shown in Figure 6.9, where the green lines to be printed by Extruder 1 and the blue lines by Extruder 2.

![Figure 6.9: Loading Artifex 2 Duo nozzle offsets calibration model](http://3dmakerworld.com)

• After printing out the model, check the location where the green and blue lines align to each other. Each marker line represents an additional 0.1mm offset. Figure 6.10 shows the additional offsets for Extruder 2 are: $X = 0.7\,mm$, and $Y = -0.3\,mm$. 
Then, in Repetier-Host, go to the “Manual Control” page, enter the G-code command “M218 T1 X42.7 Y-0.3”, and click “Send” (Figure 6.11). This G-code command will modify the offsets of Extruder 2 to \( X = 42.7 \text{ mm} \) and \( Y = -0.3 \text{ mm} \) based on the above calibration results. After this change, you can reprint the calibration model to verify the new offset settings. Under the new settings, the green and blue lines should align to each other at the 0 position on both X-axis and Y-axis directions.

For users who feel comfortable to change the firmware code, the nozzle distance can also be defined in the file `Configuration.h`:

```c
#define EXTRUDER_OFFSET_X {0.0, 42.0}
#define EXTRUDER_OFFSET_Y {0.0, 0.0}
```

---

Figure 6.10: Defining additional nozzle offsets

Figure 6.11: Adjusting extruder offsets
6.3 Printing with two colors

Repetier-Host provides good support for printing with two colors. The steps for preparing and printing two-color models are explained as follows:

- Download the example models from our website, and load them into Repetier-Host (Figure 6.12).

![Figure 6.12: Loading two color models into Repetier-Host](http://3dmakerworld.com)

- Select the extruder for each color (Figure 6.13).
• Merge two color models into one group by dragging one color model into the group of another color model (Figure 6.14).

• The merged two-color model can be operated as a regular one color model. In Figure 6.15 the merged model is scaled down to 60% of its original size.
Then, the model is ready for slicing using the slicer of your choice (Figure 6.15).

![Figure 6.15: Scaling the merged two-color model](http://3dmakerworld.com)

After slicing, the generated G-code can be reviewed in Repetier-Host before sending it to the printer. Figure 6.17 shows the 3D preview of G-code generated by Slic3r.

![Figure 6.16: Slicing the two-color model](http://3dmakerworld.com)

![Figure 6.17](http://3dmakerworld.com)
CuraEngine has a nice feature of “Create Wipe and Prime Tower” for printing with dual extruders to assist the process of extruder switch. Figure 6.18 shows the 3D preview of G-code generated by CuraEngine with the wipe and prime tower on the side. Both Slic3r and CuraEngine configuration files can be downloaded from our website.
6.4 Printing with dissolvable support materials

With two extruders, Artifex 2 Duo can be used to print out difficult models with dissolvable support materials, like HIPS or PVA. The set-up process is similar to what explained in the last section for two-color printing. The following example shows the printing process of a Hilbert Cube (thing:16343) using ABS for the model and HIPS for the support.

- First, download the model files, HilbertCube.stl and HilbertCubeSupport.stl, from our website. Then, follow the instructions in Section 6.3 to load both models into Repetier-Host, merge them into one group, and assign the appropriate extruder for each model (Figure 6.19). In this example, Extruder 1 was used for the model using ABS filament, and Extruder 2 for the support structure using HIPS filament.

![Figure 6.19: Loading the model of Hilbert Cube into Repetier-Host](http://3dmakerworld.com)

- Then, slice the model using the slicer of your selection. In Figure 6.20, the CuraEngine was used to generate the G-code.

http://3dmakerworld.com
• The preview of generated G-code is shown in Figure 6.21. After printed out, the HIPS support structure can be dissolved in a Limonene bath.
6.5 Using one extruder

The Artifex 2 Duo can also be used as a single extruder 3D printer to print with a single filament spool. In such configuration, the left extruder is the active extruder.

First, create a new printer profile “Artifex 2 Duo_Single” in Repetier-Host, and use all the settings of “Artifex 2” as shown in Section 2.1.3 except for the settings of “Printer Shape” (Figure 6.22).

![Printer Settings](image)

Figure 6.22: Defining the printer shape of Artifex 2 Duo for single extruder usage

Once the new printer profile is created, the Artifex 2 Duo works as a single extruder Artifex 2, and can use all the settings and configurations of Artifex 2. For example, the model shown in Section 3.2.3 can be sliced using CuraEngine using the Print Setting “Artifex 2” and the Filament setting “PLA” as shown in Figure 6.23.
Figure 6.23: Applying Artifex 2 slicing settings to Artifex 2 Duo for printing with single extruder
7 Printing with LCD Controller

Artifex 2 comes with a large 128 x 64 LCD controller with full size SD card reader (Figure 7.1). The printer can be operated untethered without being connected to a computer.

![Figure 7.1: Artifex 2 LCD controller](image)

The main control screen (Figure 7.2) is entered by pressing the rotary knob on the LCD controller.

![Figure 7.2: The main control screen of Artifex 2 LCD controller](image)

The control commands can be selected by rotating and pressing the rotary knob. Commands under the “Prepare” menu (Figure 7.3) are often used to home and move axes, and preheat the printer. Commands under the “Control” menu are used to change the default printer configurations, and are not usually needed for standard printing jobs. “Print from SD” is used to select printing files stored on the SD card.
On Artifex 2 Duo, there are two extruders under the “Move Axis” menu to assist the filament feeding and retraction of both extruders (Figure 7.4).

The LCD controller can provide great convenience to the following example tasks:

- **Leveling the bed**: Combining the commands “Home Z” and “Lift Z”, you can conveniently level the bed quickly without connecting the printer to a computer.

- **Changing filaments**: After preheating the extruder, you can quickly retract the old filament and feed the new filament via the command “Move Axis → Extruder (or, Extruder 1 and 2 for Artifex 2 Duo)”. 

**Figure 7.3: Artifex 2 LCD controller: Prepare menu tree**

**Figure 7.4: Artifex 2 Duo LCD controller: Prepare menu tree**
• **Printing large jobs:** For large printing jobs, the LCD controller can free up your computer for many hours, and reduce the chance that the job gets ruined due to disconnected USB cable, automatic computer update and restart, and other unplanned interruptions.
8 Support

If you experience any difficulty when operating the Artifex 2 3D Printer, please contact us at:

- Email: support@3dmakerworld.com
- Phone: (913)897-8359
- Submit your questions: http://www.3dmakerworld.com/contacts

For updates of software/documents and other technical support topics, please visit us at http://www.3dmakerworld.com/support.

Please review the *Build Instructions* (Figure 8.1) if you are building the Artifex 2 3D Printer from a DIY kit.

![Image of Build Instructions]

Figure 8.1: The Build Instructions of Artifex 2 3D Printer

Thanks for your purchase of 3DMakerWorld Artifex 2 3D Printer. 

*Enjoy your printing!*

http://3dmakerworld.com